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2 第 1章 はじめに

第1章

はじめに

本稿は，「パワーエレクトロニクスノート ー製作演習付き講義の実践記録ー」で使用して

いる，PICマイコン PIC16F1825による正弦波発生器，PWM信号発生器のプログラム

とその動作について解説します．

本稿では各種モジュールの設定関数と専用の用語を使用しています．これら関数と用

語は

モータドライブノート　 I. PIC16F1825によるDCモータの回転数制御

に詳述してあります．このpdfファイルをダウンロードして，本稿と一緒にお読み下さい．

https://www.amazon.co.jp/gp/product/B082LQ3Y5Q?pf_rd_p=3d322af3-60ce-4778-b834-9b7ade73f617&pf_rd_r=CNY0ZF70MYW6DVDQKRXB
http://mybook-pub-site.sakura.ne.jp/Motor_Drive_note/index.html
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第2章

PIC16F1825の正弦波生成モードとPWM信号

生成モードおよび動作例

2.1 正弦波生成モード

2.1.1 部品

図 2.1: PIC16F1825

Fig. 2.1は PIC16F1825の外観，立体図および電源接続の様子です．このマイコンは

Microchip社の製品です．DIP(Dual In-line Package)と呼ばれるパッケージのものを選び

ました．電極（ピン）が 2列に並んでいて，プリント基板，ブレッドボードに差し込め

るタイプです．PIC16F1825は 14ピンを持ち，これらのピン 7個ずつが 2列に配置され

ています．ピン番号は，同図 (b)の立体図の通り，パッケージに設けられた凹みを左に見

て，その左下から反時計回りに 1⃝→ 2⃝→・・・→ 14⃝と付けられています． このマイコンの
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場合，電源は同図 (c)のように， 1⃝番ピンに電源の＋側，14⃝番ピンに電源の－側（GND：

Ground）をつなぎます．

図 2.2: PIC16F1825のピン配置

Fig. 2.2はPIC16F1825のピン配置を示します． 2⃝番ピンから 13⃝番ピンまでは複数の機
能が割り当てられていて，プログラムにより選択できます．RAx, RCxは I/O(Input/Output)

ポートです．ANxはアナログ入力ポートであり，A/D変換モジュールをつなげられます．

PxA,PxBはPWM信号の出力ピンです．MCLRは，Master Clearの略で，MCLRとオー

バーラインが付いているので，負論理入力です．このピン（4番ピン）は通常は 5 [V]を入

力しておき，強制的にマイコンをリセット（初期化）したい場合に 0 [V]を入力します．そ

の後 5 [V]を入力すると，マイコンはmain()関数の先頭にもどって再起動します．ICSP-

DATと ICSPCLKは ICSP
TM

(In-Circuit Serial Programming)用のピンです．MPLAB R⃝

SnapなどのDebugger/Programmerを接続して，マイコンへのプログラム書き込み，デ

バッグを行うことができます．

Fig. 2.3は可変抵抗器の外観と内部構造および記号です．可変抵抗器は抵抗値を変化

させられる抵抗器です．写真のタイプは a, b, cの 3電極を持ちます．抵抗器上面の灰色

部分をネジ回しで回転させると，b電極の先が連動して a-c 間の抵抗体表面を摺動しま

す．これにより，a-b間，b-c間の抵抗値を変化させられます．a-c間の抵抗値は固定です．

図 (b)最下図のように，灰色部分を時計方向いっぱいに回すと，a-b間の抵抗Ra−b最小，

b-c間の抵抗Rb−c最大となります．逆に図 (b)最上図のように，反時計方向いっぱいに回

すと，Ra−b最大，Rb−c最小となります．抵抗器の全面に a-c間の抵抗値が印字されてい
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図 2.3: 可変抵抗器

ます．写真の例は 202です．この数値の意味は

202 = 20× 102[Ω]

= 2[kΩ] (2.1)

です．したがって，Ra−b, Rb−cの変化範囲は

Ra−b = 0 ∼ 2[kΩ]

Rb−c = 2[kΩ]−Ra−b

= 2 ∼ 0[kΩ] (2.2)

です．

写真の可変抵抗器は半固定形です．ネジ回しでなく，指でつまんで回せるタイプの可

変抵抗器と区別するために，半固定形と呼ばれます．また，可変抵抗器はボリュームと

も呼ばれます．写真のタイプのボリュームは半固定ボリュームとも呼ばれます．
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図 2.4: 電池ボックス

Fig. 2.4は電池ボックスの外観と記号です．単 3乾電池 4本を直列接続で収納できる

タイプです．出力電圧は乾電池の場合 6 [V]，充電池の場合 5 [V]です．赤い電線が電池

の＋側，黒い電線が－側つながっています．電源スイッチが付いているので，容易に電

源のオン／オフ切替ができます．
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図 2.5: ブレッドボード

Fig. 2.5はブレッドボードの外観とボード内部での穴のつながりの様子です．□がジャ

ンパ線を差し込める穴です．黒い線によりブレッドボード内部での穴同士のつながりを

示します．最上段の 2行と最下段の 2行は，各行内の 50個の穴が内部でつながれていま

す．これら上下各 2行の穴に挟まれて 63列の穴があります．各列には 10個の穴があり，

A～E，F～Jの 5個ずつが内部でつながれています．
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2.1.2 正弦波生成の実験回路

図 2.6: 正弦波生成実験の回路図

Fig. 2.6は正弦波生成実験の回路図です．マイコンには第 4章のプログラムが書き込ま

れている前提です．RC0（10番ピン），RA2（11番ピン）ポートをGNDにつないで電

源を投入すると正弦波生成プログラムが走ります．正弦波電圧はRA5（2番ピン），RC5

（5番ピン）に出力されます．AN6（8番ピン）はアナログ入力ポートで，マイコン内の

A/D変換モジュールにつながれています．可変抵抗器の b電極を動かすことで，AN6へ

の入力電圧 vcomを変えられます．この電圧に応じて，マイコン内のプログラムが RA5，

RC5に出力される正弦波電圧の周波数を変化させます．

図 2.7: 正弦波生成実験回路の立体配線図

Fig. 2.7は正弦波生成実験回路の立体配線図です．回路図と実際の部品との関係を把
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握し易くするために立体図を用いて配線の様子を描いてあります．

図 2.8: 正弦波生成実験回路の配線写真

Fig. 2.8は正弦波生成実験回路の配線写真です．図 2.7の立体配線をブレッドボード上

で実現しています．一番上の穴行を＋電源ライン，一番下の穴行を－電源ラインとして

います．マイコンはブレッドボードの中央に設けられている溝を挟んで挿入します．ブ

レッドボードの各穴列の内部配線は図 2.5に示すように，中央の溝で切れています．この

溝を挟んで挿入することで，マイコンの各ピンに 4個ずつ配線用の穴がボード内部でつ

ながります．

図 2.9: 正弦波生成実験回路の動作波形例
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Fig. 2.9は正弦波生成実験回路の動作波形例です．オシロスコープ画面のスナップショッ

トは横軸が 1 [sec/div]（一目盛り当たりの値）であり，縦軸が 2 [V/div]です．同図 (a)は

出力正弦波の周波数が高い（約 0.5 [Hz]）場合，(b)は低い（約 0.2 [Hz]）場合です．vcom

が高いときに周波数が高くなるようにプログラムしてあります．

なお，このマイコンはアナログ電圧を出力する機能を持っていません．RA5，RC5に

出力できる電圧は VDD（電源電圧）と 0 [V]の 2値です．この 2値を使って，Fig. 2.9

の波形例のような正弦波電圧を生成する手法が PWM(Pulse Width Modulation)制御法

です．

図 2.10: PWM制御法の基本概念

Fig. 2.10は PWM制御法の基本概念です．RA5，RC5ポートの出力電圧をそれぞれ

vRA5, vRC5とします．同図右は vRA5のイメージ図です．TPWM はスイッチング周期と呼

ばれます．Thighは vRA5 = V DDの期間です．vRA5の平均値を vRA5とすると

vRA5 =
Thigh

TPWM

V DD (2.3)

です．Thigh期間の vRA5の波形はパルスと呼ばれます．Thighはパルス幅です．PWM制御

法はパルス幅を制御する方法です．正弦波の周期を Tsinとします．PWM周期 TPWM を

正弦波の周期 Tsinに対して十分に短くします．すなわち，

TPWM << Tsin (2.4)

とします．そして，vRA5のTPWMごとの平均値 vRA5が近似的に正弦波となるようにThigh

を制御します．

Fig. 2.11は PWM制御法による正弦波生成のイメージ図です．図は

TPWM =
Tsin

20
(2.5)

の例です．実際には両周期にはもっと大きな差をつけるのですが，ここでは図の見やす

さを優先して 20と小さな値にしています．vRA5が正弦波の正の半波を担当し，vRC5が



2.1. 正弦波生成モード 11

図 2.11: PWM制御法による正弦波生成のイメージ図

負の半波を担当しています．マイコンの 2番ピント 5番ピンの間の電圧は，5番ピンを基

準にすると，vRA5 − vRC5です．この電圧の TPWM 毎の平均値 vRA5 − vRC5は近似的に正

弦波となります．

Fig. 2.12は vRA5, vRC5と voの実験波形例を示します．正弦波の周期 TsinとPWM周期

TPWM の関係は

TPWM =
Tsin

240
(2.6)

です．同図 (a)が正弦波の周波数が低い（周期が長い）場合で，(b)が周波数が高い（周

期が短い）場合です．vRA5, vRC5の波形には，パルスが重なってべた塗りの状態で表示さ

れている区間が見られます．抵抗R2とコンデンサC1はフィルタ回路です．フィルタに

より細いパルスを除去することで図中の voの正弦波形を見ることができます．フィルタ

回路の入力電圧 vin = vRA5 − vRC5とすると，voと vinの間には

vo =
1

R2 +
1

jωC1

× 1

jωC1

vin

=
1

1 + jωC1R2

vin (2.7)

の関係があります．ωは vinの角周波数です．

ω = 2πf (2.8)

です．f は vinの周波数です．これはローパスフィルタの特性です．なぜならば，

vo ≈ vin

(
ω <<

1

C1R2

)
vo ≈ 0

(
ω >>

1

C1R2

)
(2.9)
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図 2.12: PWM波形と正弦波形

となり，vinの周波数 f が低いときは，vinがそのまま voに現れ，f が高いとき voは 0 に

近づくからです．

fc =
1

2πC1R2

(2.10)

はカットオフ周波数と呼ばれます．カットオフ周波数において

|vo| =
1√

1 + (2πfcC1R2)2
|vin|

=
1√
2
|vin|

(2.11)

です．出力電圧の絶対値 |vo|は入力電圧の絶対値 |vin|の 1/
√
2となります．この比 |vo|/|vin|

は f > fcにて小さくなります．fcをもって，ローパスフィルタが通す周波数成分の目安

とします．

Fig. 2.12の例ではR2 = 100 [kΩ]，C1 = 1 [µF]です．よって

fc =
1

2πC1R2

=
1

2π × 10−6 × 105

≈ 1.6[Hz] (2.12)
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です．図 (a)の場合，PWM周期 TPWM ≈ 22 [msec]です．したがって，PWM周波数

fPWM は

fPWM =
1

TPWM

≈ 1

22[msec]

≈ 45[Hz] (2.13)

です．

fPWM >> fc (2.14)

の関係が成立し，PWM周波数成分はフィルタ出力 voにはほとんど現れません．実際に

計算してみると

|vo| =
1√

1 +
(

f
fc

)2
|vin|

≈ 1√
1 +

(
45
1.6

)2 |vin|
≈ 0.035|vin| (2.15)

となり，6 [V]のパルスは 0.2 [V]程度に減衰します．このため，Fig. 2.12の voの波形に

はパルス状波形は見えません．

一方，例えば 0.5 [Hz]の正弦波は

|vo| ≈ 1√
1 +

(
0.5
1.6

)2 |vin|
≈ 0.95|vin| (2.16)

となり，5%程度の減衰で済みます．カットオフ周波数より低い成分は，TPWM の区間毎

の平均値 vRA5 − vRC5に近い値に均されます．
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図 2.13: PWM波形と正弦波形（時間軸拡大図）

Fig. 2.13は Fig. 2.12の時間軸を拡大した波形例です．Fig. 2.12ではべた塗りとなっ

てしまっていた箇所において，時間軸を拡大することで，パルス上の波形が見えるよう

になりました．vRA5のパルス幅 Thighが拡がるにつれて，出力電圧 voが大きくなって行

く様子が分ります．
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2.2 PWMモード

2.2.1 可視化PWMモード

図 2.14: 3種類のモード設定立体配線図

第 4章のプロラムには正弦波生成モードの他に可視化PWMモードとモータドライブ・

D級アンプ用PWMモードがあります．電源投入前に Fig. 2.14(a)のように 10，11番ピ

ンをGNDにつないで電源を投入すると，正弦波生成モード用プログラムが走ります．正

弦波電圧は 2，5番ピン間に出力されます．10番ピンをGND，11番ピンを＋電源側につ

なぐと可視化PWMモード用プログラムが実行されます．PWM制御法の仕組みを LED

の点滅で確認できます．そして，10, 11番ピンともに＋電源側につなぐと，このマイコ

ンはモータドライブ・D級アンプ用 PWM信号を生成します．PWM信号は 2番ピンと

GND間，3番ピンとGND間に出力されます．2，3番ピンのPWM信号は相補的（一方

が＋V/GNDを出力しているとき，もう一方はGND/＋Vにつながっている関係）です．

正弦波生成モードは 2.1節に解説したので，本節では 2種類の PWMモードを解説し

ます．

Fig. 2.15は可視化PWMモードの動作波形例です．同図 (a)が通流率が高い場合，(b)

が低い場合です．PWM制御法の基本概念はFig. 2.10に述べたものと同じです．通流率を
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図 2.15: 可視化 PWMモードの動作波形例

δ，PWM周期を TPWM，パルス幅を Thighとすると

δ =
Thigh

TPWM

(2.17)

です．(a), (b)ともに TPWM ≈ 2 [sec]です．マイコン内のプログラムは 8番ピンの電圧

vcomをA/D変換モジュールにより読み込んで，vcomが高いときに通流率 δが高くなるよ

うに制御しています．同図 (a)の回路図のように 3番ピンとGND間に，抵抗R2と LED

（Light Emitting Diode：発光ダイオード）を直列に接続することで，PWM制御の様子

を LEDの点滅で確認できます．
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2.2.2 モータドライブ・D級アンプ用PWMモード

図 2.16: モータドライブ・D級アンプ用 PWMモードの動作波形例

Fig. 2.16はモータドライブ・D級アンプ用PWMモードの動作波形例です．2, 3番ピンの

出力電圧をそれぞれ vPWM1, vPWM2とします．前項の可視化PWMモードとの大きな違い

はPWM周期TPWMです．オシロスコープ画面のスナップショットからTPWM ≈ 32[µsec]

です．同図 (a)が vPWM1の通流率が高い場合，(b)が低い場合です．マイコン内のプログ

ラムは 8番ピンの電圧 vcomを A/D変換モジュールにより読み込んで，vcomが高いとき

に vPWM1の通流率 δが高くなるように制御しています．vPWM1, vPWM2は相補的（一方

が＋V/0を出力しているとき，もう一方は 0/＋Vを出力している関係）であることが分

ります．
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第3章

MPLAB R⃝ X IDE, XC8 コンパイラ，New

Project，デバッガ

3.1 MPLAB R⃝ X IDE, XC8 コンパイラのインストール方法

本章ではMicrochip社が無償提供している統合開発環境MPLAB R⃝ X IDE (Integrated

Development Environment：統合開発環境，および，MPLAB R⃝ XC8コンパイラのダウ

ンロード，インストール方法と使用方法の概要を紹介します．

MPLAB R⃝ X IDE はMicrochip社のホームページ → Design Support → Development

Tools → Overview → MPLAB R⃝ X IDE → Downloads → MPLAB R⃝ X IDE v5.25 (2019

年 9月時点)とたどることでインストーラ (MPLABX-v5.25-windows-installer.exe)をダウ

ンロードできます．このインストーラを立ち上げ，インストーラの推奨通りにNextボタ

ンを押していくことで，MPLAB R⃝ X IDEをインストールできます．無事インストールに

成功すれば，C:Y=Program Files (x86)のフォルダ内にMicrochipという名前のフォルダ，

ドキュメントフォルダ内にMPLABXProjectsという名前のフォルダが作られています．

同様に，MPLAB R⃝ XC8 コンパイラはMicrochip社のホームページ → Design Support

→ Development Tools → Overview → MPLAB R⃝ XC → Downloads → MPLAB R⃝ XC8

Compiler v2.10 (2019年 9月時点)とたどることでインストーラ (xc8-v2.10-full-install-

windows-installer.exe)をダウンロードできます．このインストーラを立ち上げ，推奨通

りにNextボタンを押していくことで，XC8コンパイラをインストールできます．無事イ

ンストールに成功すると，Microchipフォルダ内に xc8Y=v2.10という名前のフォルダが作

られています．v2.10Y=picY=includeフォルダ内に本稿で用いるヘッダファイル xc.hがダウ

ンロードされています．

本稿で解説するソースコードは，本稿と同じ

パワーエレクトロニクスノート

圧縮ファイル sin wave 2types PWM for Web up.zip にあります．ダウンロード，解凍し

http://mybook-pub-site.sakura.ne.jp/Power_Electronics_Note/index.html
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てお使いください．
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3.2 New Projectの作成方法

図 3.1: MPLAB R⃝ X IDEの立ち上げとNew Projectの設定

第 4章で詳述するファイルを用いて，MPLAB R⃝ X IDEによる編集，マイコンへの書

き込み方法を記します．

MPLAB R⃝ X IDEのアイコンを左ダブルクリックすることで，この統合開発環境を立

ち上げることができます．図 3.1の画面が立ち上がったら，File→New Projectを選択し

ます．次に図 3.2のように進み，デバイスとして PIC16F1825を選択します．

図 3.2: MPLAB R⃝ X IDE: Device選択

その後は図3.3のようにデバッグツールとしてSnapを選択し，コンパイラにXC8(vx.xx)....

を選択します．図 3.4は次に表示される画面です．あらかじめ作っておいたフォルダ（例
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えば，MPLABXProjectsフォルダ内にPIC16F1825という名前のフォルダを作っておく）

をブラウズし，プロジェクト名を自分で決めて（例えば，sin wave 2types PWM としま

す．）入力し，”Set as main project”にチェックを入れて，言語に Shift JISを選択します．

図 3.3: MPLAB R⃝ X IDE: tool, compiler選択

図 3.4: MPLAB R⃝ X IDE: project name, folder, 言語選択

以上が完了した段階で，（上の例ではPIC16F1825のフォルダ内に sin wave 2types PWM

という名前の）フォルダが作られています．図 3.5のように，このフォルダの中へ

パワーエレクトロニクスノート

からダウンロードしておいた「sin wave 2types PWM for Web up」フォルダ内のソース

ファイル (main.c)および関連ファイルの入っているフォルダ (PIC16F1825 Files)をコピー

します．

次に，これらのファイルをプロジェクトに追加します．図 3.6のように，Source Files

のフォルダを右クリックし，ADD Existing Itemを選択します．そして，同図右のよう

http://mybook-pub-site.sakura.ne.jp/Power_Electronics_Note/index.html
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図 3.5: ソースファイル，関連フォルダの sin wave 2types PWMフォルダ内へのコピー

図 3.6: MPLAB R⃝ X IDE: Source fileの追加

にmain.cを選択します．次に，図 3.7のように，Linker Filesを選択して右クリックし，

ADD Existing Itemを選択します．そして，同図右のように，set ad converter.c, set osc.c,

set pwm.c, set timer1.c, set timer2.cを選択します．

最後に，図 3.8の画面のように，Header Filesのフォルダを右クリックして，ヘッダファ

イル pic16f1825 s.hを追加します．
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図 3.7: MPLAB R⃝ X IDE: Linker filesの追加

図 3.8: MPLAB R⃝ X IDE: Headerの追加
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3.3 プログラムのマイコンへの書き込み

図 3.9: In-Circuit Debugger/Prgrammerによるプログラム書き込み用回路

MPLAB R⃝ X IDEの準備が整ったら，プログラム書き込み用回路の製作です．Fig. 3.9

は In-Circuit Debugger/Programmer によるプログラム書き込み用回路です．Microchip

社の In-Circuit Debegger/Programmerにはいくつかありますが，この回路はMPLAB R⃝

Snap, PICkit
TM

4用です．Fig. 2.6の正弦波生成実験回路に ICSPコネクタと全波整流回

路をつなげてあります．ICSPは In-Circuit Serial Programmingの略です．ISCPコネク

タにMPLAB R⃝ Snap, PICkit
TM

4をつなぐことで，プログラムの書き込みとデバッギング

ができます．コネクタの各ピンの名称は，これらピンとつながるマイコン側のピンの名称

（MCLR, ICSPDAT, ICSPCLK)を記してあります．全波整流回路はLED LED1 ∼ LED5

と抵抗R4からなり，正弦波を全波整流する様子を LEDで可視化します．
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図 3.10: In-circuit Prgrammerによるプログラム書き込み用回路の立体配線図

図 3.11: プログラム書き込み成功したときの回路動作

Fig. 3.10はプログラム書き込み用回路の立体配線図です．ICSPコネクタは 2個の部

品（ピンヘッダ，ピンソケット）を組み合わせて作ります．Fig. 3.11はプログラム書き

込みが成功したときの回路動作を示します．第 4章のプログラムの書き込みに成功する

と，マイコンは 2.1節の正弦波生成モードで動作します．正の半波（vRA5 > vRC5）のと

き，同図 (a)のように LED1, LED3, LED5が点灯し，負の半波（vRA5 < vRC5）のとき，

同図 (b)のように LED2, LED4, LED5が点灯します．各 LEDの明るさは正弦波電圧に

応じて変化します．
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図 3.12: In-circuit Prgrammerによるプログラム書き込み用回路の写真

図 3.13: ピンヘッダとピンソケット

Fig. 3.12はプログラム書き込み用回路の写真です．ICSPコネクタは，Fig. 3.13の 6

ピンのピンヘッダとピンソケットを組み合わせて作ります．
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図 3.14: ICSPコネクタの製作

Fig.3.14は ICSPコネクタの製作過程を示します．同図 (a)の破線で囲った 6個の穴に

ピンヘッドを挿入します．同図 (b)がピンヘッダを挿入した写真です．このピンヘッダに

ピンソケットを挿入して ICSPコネクタができあがります．

図 3.15: MPLAB R⃝ Snap

Fig. 3.15はMPLAB R⃝ Snapの外観とピン配置を示します．ICSPコネクタのピン穴は 8

個あります．▼記号側が 1番ピンです．Fig.3.14のオスビンを挿入できます．左側はUSB

コネクタで，パソコンと接続できます．
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図 3.16: ICSPコネクタにMPLAB R⃝ Snapを接続

Fig. 3.16はFig.3.14の ICSPコネクタにMPLAB R⃝ Snapを挿入した様子です．写真の

ように，左端を揃えて挿入します．MPLAB R⃝ SnapはUSBケーブルによりパソコンとつ

なぐことができ，パソコンよりプログラム書き込みおよびデバッギングができます．
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図 3.17: ゼロプレッシャーソケット

図 3.18: ゼロプレッシャーソケット使用によるマイコン挿抜の容易化

以上でマイコンにプログラム書き込みができるようになったのですが，たくさんのマ

イコン（例えば 100個）にプログラム書き込みを行うには，マイコンのブレッドボードへ

の挿抜が手間です．そのようなときにはゼロプレッシャーソケットが便利です．Fig. 3.17

はゼロプレッシャーソケットの外観です．写真のようにレバーを立てた状態では，ソケッ

ト口は広く開いていて，圧力ゼロ（ゼロプレッシャー）でマイコンをソケット口に挿入

できます．レバーを倒すとソケット口が固く閉じるため，マイコンをゼロプレッシャー

ソケットに固定できます．そこで，あらかじめゼロプレッシャーソケットだけをブレッド

ボードに差し込んでおきます．そして，マイコンをソケット口に挿入してレバーを倒す

ことで，マイコンを回路に接続できます．Fig. 3.18はゼロプレッシャーソケットにより

マイコンをブレッドボード上の回路に接続した様子です．これでマイコンにプログラム

を書き込むことができます．書き込み後は，レバーを立てることでマイコンを抵抗なく

ソケットから抜き取ることができます．
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図 3.19: MPLAB R⃝ X IDE: Build

以上でMPLAB R⃝ X IDEによるプログラムの編集，PICマイコンへの書き込み準備が

完了しました．電池ボックスに 4本の乾電池 (6[V])もしくは充電池 (5[V])を入れて，ブ

レッドボードの＋電源およびGNDラインに接続して電圧を印加します．ICSPコネクタ

にMPLAB R⃝ SnapもしくはPICkit
TM

4を接続し，MPLAB R⃝ Snap PICkit
TM

4とパソコ

ンをUSBケーブルで接続します．

図 3.19のように，画面内のmain.cを左ダブルクリックすることで，このファイル内の

プログラムを開くことができます．そして，Build Main Projectボタンをクリックして，

同図下のように

　BUILD SUCCESSFUL (total time: xxs)

のメッセージが出れば，全ての準備が完了です．

Fig. 3.20のように�ボタンを押すとプログラムのBuildとマイコンへの書き込みを実

行します．同図下の画面のように

　 Programming/Verify complete
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図 3.20: MPLAB R⃝ X IDE: Buildとマイコンへの書き込み

が表示されれば，書き込みが完了し，Fig. 3.11の様に LEDがゆっくりと明るさを変化

させるはずです．可変抵抗器上面のつまみをネジ回しで回すと，LEDの明かりの変化速

度が変わります．
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3.4 デバッガの使用方法

図 3.21: デバッガの起動

図 3.22: デバッガの一時停止

プログラムを改変したいときにはデバッガが便利です．Fig. 3.21のDebug Main Project

１ボタンを左クリックすることで，プログラムのビルドとマイコンへの書き込み，デバッ

ガの起動を実行します．そして，Fig. 3.22のPauseボタンを左クリックすることで，プ

ログラムを一時停止できます．そして，この停止時のグローバル変数の値，レジスタの

値などを表示させることができます．例えば，第 4章のプログラムは，8番ピンの入力電
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図 3.23: 表示データの指定

圧をA/D変換して 10ビットの値で読み出し，グローバル変数 ad outに格納します．図

3.23はマイコンの一時停止中に，ad outの値を表示している画面です．Enter new watch

を右クリックすると，プルダウンメニューが表示されます．New Watchを選択すると，表

示可能なレジスタおよび変数の一覧が表示されます．その中から ad outを選択してOK

ボタンを押すと，図のように ad outの値が表示されます．値の表示形式は 10進，16進，

2進を選べます．
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第4章

プログラム

本章では sin wave 2types PWM.cのプログラムを解説します．本稿で使用する関数，ヘッ

ダファイルは全て

モータドライブノート　 I. PIC16F1825によるDCモータの回転数制御

にて詳細に記述してありますので，こちらを参照して下さい．

4.1 ヘッダファイル

図 4.1: ヘッダファイルのインクルード

Fig. 4.1はヘッダファイルのインクルードです．pic16f1825 s.hは筆者オリジナルのヘッ

ダファイルです．上述の「I. PIC16F1825による DCモータの回転数制御」にて，オシ

レータ，タイマー 1, 2，A/D変換，PWM等の各モジュール設定用関数を作成し，その

引数に分かり易い表現を採用しました．そして，その表現とレジスタの数値との対応表

をヘッダファイル pic16f1825 s.h にまとめてあります．　

http://mybook-pub-site.sakura.ne.jp/Motor_Drive_note/index.html
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4.2 デバイスコンフィギュレーション

図 4.2: デバイスコンフィギュレーション

図 4.2はデバイスコンフィギュレーションです．本稿では

FOSC = INTOSC：内蔵オシレータオン，RA5（2番ピン）を I/O用に設定

MCLRE = ON：MCLRピン（4番ピン）による強制リセットを可能とする

PLLEN = ON：内蔵オシレータにより得られたクロックを PLLにより 4倍にする

BORV = HI：低電圧リセット電圧を 2.7[V]に設定

LVP = ON：低電圧 (例えば 3.3[V])でのプログラミングオン

のみ設定しています．実験室レベルでは，これで十分です．MPLAB SnapはLVP = ON

でのみ，書き込み可能なので注意してください．
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4.3 メイン関数

図 4.3: メイン関数

図 4.3はメイン関数です．

TRISA = 0x04;

TRISC = Ox05; (4.1)

により，RA2(11番ピン)，RC2(8番ピン), RC0(10番ピン)を入力ポートに設定し，さ

らに，

ANSELA = 0x00;

ANSELC = 0x04; (4.2)

により，RA2(11番ピン)，RC0(10番ピン)をディジタル入力，RC2(8番ピン)をアナロ
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グ入力に設定しています．

　 set osc(Int OSC Freq 8MHz, SysClockSource detmd by Config);

により，内蔵オシレータのクロック (16 [MHz])をプリスケーラにより 8 [MHz]とし，

４逓倍 PLLにより 32 [MHz]としてシステムクロック FOSCを 32 [MHz]に設定しま

す．set osc()関数は，set osc.cファイル内で定義され，引数の用語 (Int OSC Freq 8MHz,

SysClockSource detmd by Config）はヘッダファイル pic16f1825 s.h 内で定義されてい

ます．詳細はモータドライブノート　 I. PIC16F1825によるDCモータの回転数制御を

参照して下さい．以降の関数及び用語の定義も同様です．

　 set timer1(TMR1 clock source FOSC, T1Clock PreScale 1 1, TMR1 ON);

により，タイマ１のクロックソースをシステムクロック FOSCとし，クロックの分周率

を 1:1 に設定して，タイマ 1をオンとします．

　 set interrupt by timer1();

により，タイマ 1による割り込み可とします．

　 set AD Converter(select AN6, AD ON, right justified, clock 1 32, neg ref VSS,

　　　　　　　　　　　 pos ref FVR);

により，A/D変換モジュールを設定します．AN6(8番ピン)をA/D変換モジュールの入

力とし，A/D変換モジュールをオンとします．このマイコンのA/D変換結果は 10ビッ

トです．結果の格納用レジスタは 16ビットなので，right justifiedにより右寄せで（下 10

ビットに）結果を格納します．クロックソースはFOSCで固定です．A/D変換器の推奨ク

ロック周波数は 0.25～1 [MHz]です．そこで，FOSC = 32 [MHz]としたので，clock 1 32

により,AD変換器のクロックを FOSC/32 = 1 [MHz]に設定します．A/D変換器の基準

電圧は，－側を電源の－側 (VSS)とし，＋側を FVR とします．FVRは

　 set FVR(FVR ON, ad ref 4 096);

により，4.096 [V]を選択します．

http://mybook-pub-site.sakura.ne.jp/Motor_Drive_note/index.html


38 第 4章 プログラム

RC0とRC2の入力値により次の３通りの場合分けをします．

RC0 = 1, RC2 = 1のとき：モータドライブ & D級アンプ用 PWMモード

RC0 = 0, RC2 = 0のとき：正弦波生成モード

RC0 = 0, RC2 = 1のとき：可視化 PWMモード (4.3)

モータドライブ & D級アンプ用PWMモードのときのみPWMモジュールの設定をし

ます．

　 set PWM(Half Bridge with P2A P2B, P2A B C D active high, P2B to RA4,

　　　　　　　 P2A to RA5, based on timer2);

により，PWMモジュールを設定します．ハーフブリッジのPWM信号をP2A，P2Bに

出力します．P2A, P2Bは正論理とします．P2BをRA4(3番ピン)に，P2AをRA5(5番

ピン)に割り当てます．PWMモジュールのタイマとしてタイマ 2を選択します．

　 set timer2(set Postscaler 1 1, timer2 on, set Prescaler 1 1, PWM period);

により，タイマ 2のポストスケーラを 1:1 にし，タイマ 2をオンとし，プリスケーラを

1:1 にします．デバイスコンフィギュレーションの次の行で

　#define　 PWM period　 0xFF

により，PWM period = 0xFF(16 進数) = 255(10 進数) と定義しています．PIC16F1825の

データシートより，タイマ 2のクロックは FOSC/4 です．PWM周期 TTPWM を

TPWM =
FOSC

4
× 1

256
= 32[µs] (4.4)

と設定します．詳細はモータドライブノート　 I. PIC16F1825によるDCモータの回転

数制御の PWMモジュールの項を参照して下さい．

　 for(;;)

　　 continue;

http://mybook-pub-site.sakura.ne.jp/Motor_Drive_note/index.html
http://mybook-pub-site.sakura.ne.jp/Motor_Drive_note/index.html
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は，何もしない無限ループです．この間，タイマ１による割り込みで，タイマ１割り込

みルーチンが起動されます．

4.4 タイマ１割り込み関数

図 4.4: タイマ１割り込み関数

図 4.4はタイマ１割り込み関数です．timer1 isr()はこの関数名です．どのような名前

を選んでもよいので，timer1 isr(timer1 Interrupt Service Routine)としました．

　RC3 = 1;

により，RC3(7番ピン)に１ (VDD)を出力します．そして，このルーチンの最後で

　RC3 = 0;

により，RC3に　 0 (VSS)を出力します．これにより，割り込み処理ルーチンの所要時
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間を計測することができます．

　 if(RC0 == x) && (RA2 == y)

により，(4.3)式の各モードのプログラムを実行します．

4.4.1 モータドライブ・D級アンプ用PWMモード

図 4.5: タイマ１割り込み関数 モータドライブ & D級アンプ用 PWM

図 4.5はモータドライブとD級アンプ用 PWMモードのプログラムです．

　 set timer1 count down ini num(0x0190);

により，タイマ１のカウントダウン値を設定しています．タイマ１は 0x0190からカウン

トダウンを始めて，0となったときに再び timer1 isr()を起動（することに相当する動作

を）します．タイマ１による割り込み周期 TTM1と (4.4)式のPWM周期 TPWM を同じに

するために，0x0190の数値を試行により決めました．これにより，A/D変換のサンプリ

ング周波数 fSMAP は

fSAMP =
1

TTM1

=
1

TPWM

≈ 1

32[µs]

≈ 31.2[kHz] (4.5)
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となります．

　 clear interrupt flag of timer1();

により，割り込みフラグを 0 にクリアして，次の割り込みを受け付けられるようにして

おきます．

　 set PWM duty cycle out();

により，A/D変換結果 ad outを PWMの通流率に設定します．

4.4.2 正弦波生成モード

図 4.6は正弦波生成モードのプログラムです．定数の定義と変数の宣言も併せて載せて

あります．

　 sin data[sin div+1]

に正弦波データを 61個格納します．図 4.7の通り 60個で正弦波の 1/4周期分です．プロ

グラムではこのデータをつなぎ合わせて 1周期の正弦波形を作ります．

　 Int Data = MaxInterval of PWM step - ad out*2

により，タイマ１による割り込み間隔を決定します．

　#define　MaxInterval of PWM step　 0x0820

と定義しています．A/D変換器は 10ビットなので

0 ≤ ad out ≤ 1023 (4.6)

の範囲を変化します．よって，Int Dataは

34 ≤ Int Data ≤ 2080 (4.7)

の範囲を変化します．最小値は試行により 34としました．これより小さい場合は，割り

込み時間間隔が短くなりすぎてブログラムが誤動作します．
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図 4.6: タイマ１割り込み関数 正弦波生成
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図 4.7: 正弦波データ

　 set timer1 count down ini num(Int Data); // タイマ 1のカウントダウン値の設定．

　　 clear interrupt flag of timer1();

により，次の割り込みタイミングを設定して，タイマ１による再割り込みを可とします．

　　 if(sin step < sin div){　　　　　// 正弦波データにより通流率決定

　　　　Duty = sin data[sin step];　// 0–1/4，1/2–3/4の期間の通流率

　　 }else if(sin step < sin div2){
　　　　Duty = sin data[sin div2 - sin step];//1/4–1/2，3/4–1の期間の通流率

　　 }

により，正弦波データ１周期分のデータを順次読み出してDutyに格納します．図 4.7の

1/4周期分のデータを左から順に読み出した後，次の 1/4周期は sin div2 - sin stepによ

り右から順に読み出します．正弦波形の正の半周期と負の半周期では同じデータを使い

ます．Dutyは次のプログラムで PWMの通流率を決定します．

　　 if(pwm step <= Duty){　　// PWM波形生成

　　　　 if(flag sign < 1){　　　// 正の半波

　　　　　　RA5 = 1;

　　　　 }else{　　　　　　　　// 負の半波

　　　　　　RC5 = 1;

　　　　 }
　　 }else{
　　　　RA5 = 0;
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　　　　RC5 = 0;

　　 }
　　 pwm step += 1;　　　　　　// PWMステップ +1

　　 if(pwm step >= 255){　　　// PWMステップ数最大値 = 255

　　　　 pwm step = 0;　　　　　// PWMステップ リセット

　　　　・・・

　　 }

図 4.8はこのプログラムによる PWM波形生成の様子を示します．pwm step ≤ Duty の

間は RA5（正の半波のとき）もしくは RC5（負の半波のとき）に１ (VDD)を出力し，

pwm step > Duty にて RA5 = RC5 = 0 (VSS)を出力します．pwm stepは割り込み毎

に１ずつ増加して，255に達したときに 0にリセットします．RA5およびRC5の波形が

PWM波形です．

図 4.8: PWM波形生成の様子

正の半波ではRA5のみに PWM波形を出力し，負の半波ではRC5のみに PWM波形

を出力しています．これによりRA5とRC5間の電圧は－VDD～ VDDとなります．よ

く知られている PWM波形では，RA5と RC5を相補的（一方がVDD/VSSを出力して

いるときに，もう一方はVSS/VDDを出力するよう）に用います．しかし，相補的に用

いた場合のRA5-RC5間の電圧範囲は　 0 ～ VDD と狭くなってしまいます．
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　 if(pwm step >= 255){　　　　　// PWMステップ数最大値 = 255

　　　　 pwm step = 0;　　　　　　// PWMステップ リセット

　　　　 sin step += 1;　　　　　　　//正弦波データの番地を +1

　　　　 if(sin step >= sin div2){　　// 正弦波の正負設定

　　　　　　 sin step = 0;　　　　　// 正弦波データの番地リセット

　　　　　　 if(flag sign < 1){
　　　　　　　　 flag sign = 1;　　　// 負の半波へ移行

　　　　　　 }else{
　　　　　　　　 flag sign = 0;　　　// 正の半波へ移行

　　　　　　 }
　　　　 }
　　 }

により，pwm stepが 255に達したとき，sin stepを１つ増加させます．これにより次の

割り込みで通流率が更新されます．そして，sin stepが sin div2 = 120（正弦波半周期

分のデータ数）に達したとき，sin stepをリセットします．同時に正弦波の正負フラグ

(flag sign)を反転します．

PWM波形から正弦波形が得られる様子は，2.1.2項にて述べてあります．この項を参

照して下さい．

4.4.3 可視化PWMモード

図 4.9は可視化 PWMモードのプログラムです．

　#define　 Interval of TMR1 Interrupt　 0xFFFF

によりタイマ１による割り込み周期 TTMR1を

TTMR1 =
216

32[MHz
+ α

≈ 2.05[ms] + α (4.8)

と設定します．αは主にA/D変換に要する時間です．TTMR1の実測値は約 2.07 [ms]でし

た．

　 pwm step ≤ ad out
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図 4.9: タイマ１割り込み関数 可視化 PWM

の間，RA4(3番ピン)に 1 (VDD)を出力し，

　 pwm step = 1024

で，pwm stepをリセットします．これにより PWM周期 TPWM は

TPWM = TTMR1 × 1024

≈ 2.1[sec] (4.9)

となります．

2.2.1項に実験結果を示してあります．周期が約 2.1秒なので，可変抵抗器 V R1のつま

みを回すことで，通流率の変化を LEDの点滅間隔の変化で見ることができます．
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